The purpose of this tutorial is to extract terrace riser walls from a Digital Elevation Model using
only open-source software. This tutorial is based on steps for extracting terrace walls from a
DEM using ArcGIS, which you can find here . These instructions use QGIS 2.18.0 and a
command line tool called Centerline. QGIS can be downloaded from download.qgis.org.
Centerline can be downloaded from github or downloaded using PyPI (see github page for
details).

Here are the basic steps:
1. Calculate profile curvature to find areas of high curvature (i.e. the riser walls).
2. Convert the areas of high curvature (polygons) into lines.
3. Manually clean the resulting lines.

Ready to get started?

Open QGIS and open your DEM file

nv a @

D_Q@&@»@ﬁ@ﬂp@@m[&@% @ G,y 8y 5 EH T B T, B

) e g = E we (W a abo| (abgl <abgl (abe
& - veo fx @ > B B = § ORI T TR W U o
006 Layers Panel Q06 Processing Tooloox
¢ & % T = Search. )
e v Recently used algorithms
v v [ dam asc & Topographic correction
W 169.186 /' Explode lines
436.656 P Dissolve
@ Clip

«

& Cross profiles

& Profiles from lines
i GDALIOGR [48 geoalgorit..
GRASS GIS 7 commands ...
Models [0 geoalgorithms]
Orfeo Toolbox (Image anal...
Calibration
Feature Extraction
Geometry
Image Filtering
Image Manipulation
Learning
Miscellaneous
Segmentation
Stereo
Vector Data Manipulation
» & QGIS geoalgorithms [116 ...
» & SAGA (2.2.3) [248 geoalg...
» & Scripts [0 geoalgorithms]

L

>
>
>
v

SErS08 aNNs L

<
YYYYYYYYYYR&

Coordinate 556537.3,4887463.6 ¥ Scale 1:40,593,960 & Magnifier 100% 2 Rotation 0.0 & Render ) EPSG:4326 (-]

1. Smooth the DEM: SAGA -> Raster filter -> Simple filter


https://www.researchgate.net/post/How_to_detect_extract_in_GIS_field_boundaries_walls_on_the_basis_of_DEM_and_SLOPE_raster
https://github.com/fitodic/centerline
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Compute profile curvature of smoothed DEM: SAGA -> Terrain Analysis - Morphology ->
Slope, aspect, curvature
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Result of profile curvature
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3. Crop profile curvature layer to exclude outside edges:
a) Create a mask layer for the clipping: Layer -> Create Layer -> New Shapefile Layer
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. Be sure to create a polygon and not a point layer
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b) Set the new layer to editing
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. Zoom in and you will see why you want to clip the edge
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and then zoom out to start creating a new feature
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. Be sure to save the new polygon shapefile. Then turn off editing.

c) Raster -> Extraction -> Clipper to crop the Profile Curvature layer to the mask layer
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Reclassify the clipped profile curvature layer into 2 classes: 1) wall (high curvature) and 2)

non-wall (low curvature). You may need to experiment with the threshold between the 2

classes.

a) Open the Reclassify values tool: SAGA -> Raster tools -> Reclassify values
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b) In the Reclassify values window: Grid = clipped Profile Curvature layer; Method = [1]
range; minimum value (for range) = less than minimum for curvature layer; maximum value
(for range) = threshold value (0.0 to start; 0.05, 0.1, 0.075, 0.025); new value (for range) =

-10; operator (for range): [0] <=

c) Evaluate results

Reclassify values window _Click Run.
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. Choose a reclassified grid that captures as many walls as possible. False walls will be
removed in future step.

Convert the chosen reclassified layer (I used threshold 0.01) from a raster to polygons:
GDAL/OGR -> [GDAL] Conversion -> Polygonize (raster to vector)
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. Set reclassified grid as Input layer, change Output field name ("WallBlobs"), set file to be
saved, and Run
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. Clean up the polygons before conversion to lines.
a) Delete non-wall blobs.
i) Open vectorized attribute table by right-clicking on layer in Layers Panel

@ QGIS Project Edit View Layer Settings Plugins Vector Raster Database Web MMQGIS Processing Window Help 33 & YO = I o) 100% @B = Tue10:41 Q =
e0ce QGIS 2.18.0 - Vernazza-|

DEBRLE 0 2L pHPPDIMRENRE & 6,58y, BB I 8B TV B
Y./ 8 B 200 =®E= 3D %B % e

o0 Layers Panel

Pracessing Tooloox

<« @ % T & @ & 0 ]
" . v Reo;llly used algorithms
2 Zoom to Layer Smoothing (gaussian) =
v ¥ ';' Show in Overview & simple m‘le' ?
n :; o 4 Remove & Resampling
R v g Fe D00 & Siope, aspect, curvature V)
Qv _ Set Layer Scale Visibility S Reclassily values @g
B 02 setLayer CRS & Polygonize (raster tov... 8
@ .m Set Project CRS from Layer va Saloda sty | A
| [ cu les > > is
@ e = ] v [GDAL] Conversion wg
o W oz 8 Open Attribute Table & gdal2xyz 3 |
o0os / Toggle Editing Tto RGB =
9 vO R Py SaveAs.. Tl Polygonize (rastert... =
B 160, Save As Layer Definition File... “= Rasterize (vector to... @
% W e Fier.. “5 Rasterize (write ov...
L - '43‘:' Show Feature Count % RGBtoPCT 9
v
o Propertes %, Transiate (convert ... )
b ename » [GDAL] Extraction
A 290, » [GDAL] Miscellaneous ®
Y ) [ subsets > {gggﬁ]c Projections :
| > onversion —
:\ [l subset2 » [OGR] Geoprocessing B
1 [[] subsent » [OGR] Miscellaneous
v | [ dgm-asc-subset » & GRASS GIS 7 commands ... S
W 238401 » & Models [0 geoalgorithms] A
325,097 » @ Orfeo Toolbox (Image anal...
v B dgm_asc » 7 QGIS geoalgorithms [116 ... =
M 160.186 » & SAGA(223) [248 geoalg...
436656 » 18 Scripts [0 geoalgorithms] :
=
.
.l
You can add more aigofthms totho | S
toolbox, =
Toggles the ediling state of the current layer Coordinate 566352.2,4887623.8 . Scale 1:136,046,430 Magnifier 100% | 2 Rotation 0.0 - [ Render|§) EPSG4326 | @ | |
B - A

ii) Delete non-wall polygons from the layer. Notice that there are 2 types of WallBlobs:
[-10] for non-wall polygons and [Q] for wall polygons

Vectorized :: Features total: 1511, filtered: 1511, selected: 0

/ 2 B R 5§ 8 ES8LTEP A6 BLEE =

WallBlobs

1 -10

- Ao
2
3 -10

T o
4
5 -10

o
B
7 -10

I [ )
B8

o
9

- Ao
10

o
1"

- 0|
12

o
13 1

o
14

N
15

- 0|
16

1o
T Show All Features _

. Select all non-wall polygons using Select features by value



@ QGIS Project Edit View Layer Settings Plugins Vector Raster Database Web MMQGIS Processing Window Help 33 & © = I o) 100% B2 EE Tue10:46 Q =

edce QGIS 2.18.0 - Vernazza-ExtractTerraceWalls
|, T

DoBRR VS 2L, AHPPLALSBIR @& & K & 0 B
#./ B %R RO %008 SQE%E DD A |

—IQ (5] Layers Panel | ~ Select All Features BA

V° 006 Processing Tooloox
i AT ST 2 Ve Feature Seecton ¥ Recently used algorithms
Smoothing (gaussian)
v ¥ Reclassified Grid g Simple filter
| R & Resampling
-0.01 & Slope, aspect, curvature
" v ¥ ProfileCurvature-clipped & Reclassify values
W ©.276952 ¢ Polygonize (raster to v...
@ 0.24982 GDAL/OGR (48 geoalgorit...
" M curvaturemask [GDAL] Analysis w3
% v | [ Profile Curvature Ly C;’I;"a's“’"
W 0277418 £ 9:c1 . rd
@ 0255502 8§ Polypenize (raster t =
v | [¥ Filtered Grid Lk
9 W 169.238 o0 Denterias Voo D
438770 _‘, Rasterize (write ov... 9
- % RGBtoPCT
» — =3
v | [ Vernazza-dem25cm-subset! ¥, Translate (convert ... 3
Il 161.608 » [GDAL] Extraction
AV 200.831 » [GDAL] Miscellaneous (7]
av| " [ subset3 > {gga?]cProjecﬁpns -
O > onversion s
| M subsetz » [OGR] Geoprocessing o
"1 [[] subset1 » [OGR] Miscellaneous
v [ [ dgm-asc-subset » & GRASS GIS 7 commands z\
1 238.401 » o Models [0 geoalgorithms] Y
325.037 » @ Orfeo Toolbox (Image anal
v ¥ dgm_asc » 7 QGIS geoalgorithms [116 ... =
W 169.185 » & SAGA (2.2.3) [248 geoalg... ®
436.656 » B Scripts [0 geoalgorithms] ~/
-
G .
You can add more algorithms to the =
toolbox, =

Coordinate|  556454.8,4067627.2 || Scale 1:136.045.400 |G @ Magnifer 10% | Rotaton 00 || 2 Render| ) EPSC4926 | (@ |
- - i

. Select all non-wall polygons ( value = -10)

# Select features by value

WallBlobs -10 @ Equalto(=),

Reset form Select features |T | Close

by clicking Select Features, then close the window. Selected non-wall polygons should be
yellow



. Reopen the attribute table, if you closed it, turn on editing (Pencil on far left), then click
Delete selected features (red trash can)

& Qeis $BA DD L) 0%ED E Tuel28 Q =
QGIS 2.18.0 - Vernazza-ExtractTerraceWalls

DEBRELR 0 2L A RDPLALBIS & @ |Eés.bBE = B T, B
W Y G D R E e BB = ®E R s e

2 & S

"You can add more algorithms o the
toolbox,

1000 Vectorized :: Features total: 1511, filtered: 1511, selected: 329 06 Processing Tooloox v
/ 2 BRiBED &ENGY®ESP 806 B KE: S | Gl
‘WallBlobs ‘Delete selected features . v Recently used algorithms v
— & Smoothing (gaussian)
1 I:‘I;I & Simple filter 2
2 E & Resampling
& Slope, aspect, curvature (¢)
— »
3 & Reclassify values m
— @4 Polygonize (raster to v... =
4 v i GDALIOGR [48 geoalgor.. | )
s -0 » [GDAL] Analysis "
v [GDAL] Conversion W
6 -10 & gdal2xyz 3|
= PCTo RGB
7 . Polygonize (raster t... =
40 “ Rasterize (vector to...
8 " Rasterize (write ov... @
0 0 . RGB1oPCT 9
%, Translate (convert f... )
10 -10 » [GDAL] Extraction
» [GDAL] Miscellaneous ®
1 0 » [GDAL] Projections
» [OGR] Conversion =
12 o » [OGR] Geoprocessing B
» [OGR] Miscellaneous
- >
13 v » o GRASS GIS 7 commands ... o)
| » & Models [0 geoalgorithms] A
14 » € Orfeo Toolbox (Image anal...
15 2 » / QGIS geoalgorithms [116 ... =
» & SAGA(2.23) [248 geoalg... P
16 » @ Scripts [0 geoalgorithms] ~
.
7 Show Al Features -
=
=
- B
' W
=
=

329 feature(s) selected on layer Vectorized. Coordinate 555881.8,4887551.9 § Scale 1:136,046,430 e Magnilier\:\ Rotation 0.0 |2/ [ Render &) EPSG:4326 @

. Save edits.
iii) Clip Vectorized layer to earlier Curvature Mask layer. Vector -> Geoprocessing Tools ->
Clip



® QGIS Project Edit View Layer Settings Plugins Raster Database Web MMQGIS Processing Window Help 33 & O = L[J «) 100%B) E Tuell:d2 Q =
[ XON DXF Import/Convert > pza-ExtractTerraceWalls

T = Openst M P P =
N DRO S L L O oo . LR 8 G

&L EE I B, [T,

/4 . B ] e B Geoproce: Tools » w’ Intersection
> ¥ EF 3] = Geometry Tools > | @ symmetrical difference L
06 Layers Panel Analysis Tools » | # variable distance buffer [xXo) Processing Toolbox
> Search,

Data Management Tools | # Union A
P Dissolve v Recently used algorithms

& Smoothing (gaussian)

& Simple filter

& Resampling

& Slope, aspect, curvature

& Reclassify values

I Difference
# Fixed distance buffer

»
vl B ProfileCurvature-clipped P Eliminate sliver polygons
[l -0.276952 @ Convex hull @ Polygonize (raster to v...

Va
=
Iz
@,
@ 0.24982 v i GDAL/OGR (48 geoalgorit...
&
%
74!
v

[l CurvatureMask » [GDAL] Analysis
v [ [ Profile Curvature v [GDAL] Conversion
o5 2,
0.255802
v [ | [ Filtered Grid
M 160238
436.779

“~ Rasterize (vector to.
“~ Rasterize (write ov...
% RGBtoPCT

O @ nlg i MEC e [f<

-

v ¥ Vernazza-dem25cm-subset1

¥, Translate (convert1...
Il 161.608 » [GDAL) Extraction ®
290.831 » [GDAL] Miscellaneous
av [ subsets » [GDAL] Projections =
» [OGR] Conversion
I Subsetz < {oen} Geoprocessing
[7] subsett » [OGR] Miscellaneous
v B dgm-asc-subset »  GRASS GIS 7 commands ...
W 238.491 » o Models [0 geoalgorithms]
325.037 » @ Orfeo Toolbox (Image anal...
v ¥ dgm_asc » # QGIS geoalgorithms [116 ..
M 169.186 » & SAGA (2.2.3) [248 geoalg...
436.656 » & Scripts [0 geoalgorithms]

CANRL LR oyl oX-46

Coordinate 556508.7,4887528.8 ¥ Scale 1:136,046,430 a &  Magnifier 100% ~ Rotation 0.0 2| [ Render| £ EPSG:4326

=

. Input layer = Vectorized; Clip layer = CurvatureMask, and set name for Clipped layer,
then click "Run"



| Felzsizns Log |

Input layer
Vectorized [EPSG:4326]

Run as batch process...

Clip layer
CurvatureMask [EPSG:4326]

Clipped
WallBlobs-Clipped

| Open output file after running algorithm

Clip

This algorithm clips a vector layer using
the polygons of an additional polygons
layer. Only the parts of the features in the
input layer that falls within the polygons of
the clipping layer will be added to the
resulting layer.

The attributes of the features are not
modified, although properties such as area
or length of the features will be modified
by the clipoing operation. If such
properties are stored as attributes, those
attributes will have to be manually
updated.

Close Run

b) Simplify wall blob polygons: GRASS -> Vector -> v.generalize.simplify



[’ v
[xX5) Layers Panel
« @ ® T v # & O
[] Clipped
[T Vectorized

# Reclassified Grid
| B
0.01
v E¥ ProfileCurvature-clipped
W -0.276952
0.24982
[ curvatureMask
B Profile Curvature
W 0.277418
0.255802
B Filtered Grid
W 169.238
436.779
B Vernazza-dem25cm-subset1
W 161.698
290.831
[ subset3
[l subset2
[] subsett
v ¥ dgm-asc-subset
[l 238491
325,037
v 5 dgm_asc
W 169.186
436.656

1 legend entries removed.

N

Coordinate

556229.7,4887411.3

% Scale 1:52,312,605

& Magnifier 100%

[ —

Processing Toolbox

Miscellaneous (m.")
Raster (r.")

Vector (v.*)

v.buffer.column - Creates a buffe.
v.buffer.distance - Creates a buff...
v.build.check - Checks for topolo...
v.build.polylines - Builds polyline...
v.class - Classifies attribute data.
v.clean - Toolset for cleaning top.
v.clean.advanced - Toolset for cl..
v.db.select - Prints vector map a...
v.delaunay - Creates a Delauna...
v.dissolve - Dissolves boundarie..
v.distance - Finds the nearest el...
v.drape - Converts vector map 1.
v.edit - Edits a vector map, allow...
v.extract - Selects vector objects...
v.extrude - Extrudes flat vector o...
v.generalize displacement - Vect...
v.generalize.network - Vector ba..
v.generalize.simplify - Vector ba...
v.generalize.smooth - Vector ba...
v.hull - Produces a convex hull f.
v.in.ascii.points - Creates a vect.
v.in.ascii.standard - Creates a v...
v.in.dxf - Converts files in DXFf...
v.in.geonames - Imports geona...
v.in.lidar - Converts LAS LiDAR
vin.lines - Import ASCII x,y[,2] c.
vin.mapgen - Imports Mapgen o...
vin.wis - Import GetFeature fro...
v.info - Outputs basic informatio...
vkev - Randomly partition points.
v.kernel.rast - Generates a raste.
v.kernel.vector - Generates a ve...
v.lidar.correction - Correction of t...
¢ Vlidar.edgedetection - Detects t....

EEEECECECEECECECECEECECECEECECECECEEEEEEeEEEcd

Rotation 0.0

enable

additional providers. [close]

o Render ) EPSG:4326 @

. In the v.generalize.simplify window, choose the method (I used the default "douglas”

because polygon boundaries were simplified to straight lines), save a file, and Run



Log  Help Aun as batch process...

Input layer

Clipped [EPSG:4326]
method

douglas
Maximal tolerance value

1.000000

»

Look-ahead parameter
- -
Percentage of the points in the output of 'douglas_reduction' algorithm

50.000000 ”

3

Do not copy attributes
Disable loop support

GRASS GIS 7 region extent (xmin, xmax, ymin, ymax)
[Leave blank to use min covering extent]
p Advanced parameters

Simplified
fUsers/jenglaubius/Documents/ATM/agrterrmodel/datafinterim/WallBlobs-Simplified.shp

Open output file after running algorithm

Close Run

. The resulting simplified layer has straight lines



0oBBLE IO
/ v B & @ | = WE s s A

006 Layers Panel 006 Processing Toolbox
Vo v a oy tnd 20 = I
» Miscellaneous (m."
% /! M Simplitied » Raster (%) i
[ clipped v Vector (v.*)
/D [ Vectorized & v.buffer.column - Creates a buffe..
v /B Reclassified Grid & vbufferdistance - Creates a buff...
@ W0 & V.bild.check - Checks for topolo...
av 0.01 & V.build.polylines - Builds polyline...
@ |- F ProfileCurvature-clipped & Volass - Classifies attribute data. .
1 0276952 & v.clean - Toolset for cleaning top...
024580 & V.clean.advanced - Toolset for cl...
& Il Curvaturemask & vdb.select - Prints vector map a...
&7 & vdelaunay - Creates a Delauna...
& |- JF Profile Curvature & vdissolve - Dissolves boundarie...
Wl 0277418 « vdistance - Finds the nearest el..
% 0.255802 & vdrape - Converts vector map ...
v ¥ Filtered Grid & veedit - Edits a vector map, allow...
W3 Il 160238 & Vv.extract - Selects vector objects...
436.779 & veextrude - Extrudes flat vector ..
Vil ¥ Vernazza-dem25cm-subsett & v.generalize displacement - Vect
W 161.698 & v.generalize.network - Vector ba...
290.831 . v.generalize.simplify - Vector ba...
[T Subsets & V-generalize.smooth - Vector ba...
[ subset2 & Vhull - Produces a convex hull f...
[] Subsett & vin.ascii.points - Creates a vect...
v ) PP dgnvesc-subset & vin.ascii.standard - Creates a v...
W 238491 & V.in.dxf - Converts files in DXF f...
325,037 & vingeonames - Imports geona...
- ¥ dgm_asc & Vvinlidar - Converts LAS LiDAR ..
n Tt & vinlines - Import ASCli x,y[,Z] c...
436,056 & vin.mapgen - Imports Mapgen o...
& Vinwfs - Import GetFeature fro...
& Vinfo - Outputs basic informatio...
& Vvkev - Randomly partition points...
& vkernel.rast - Generates a raste...
& vkernel.vector - Generates a ve...
& Vdlidar.correction - Correction of t...
¢ Vvlidar.edgedetection - Detects t....
‘ facttoratorovitors fgose) |
1 legend entries removed. Coordinate 556381.4,4887281.9 %’ Scale 1:52,312,605 @ Magnifier 100% 2 Rotation 0.0 z Render () EPSG:4326 ()

c) Delete very small polygons.

i) Add id and area fields to polygons. Open the attribute table for the Simplified layer. You
will need unique id numbers for lines created from the polygons later on. So add an id
field using the field calculator

& QGis A DD LW 0%ED E Tueldlo Q =

B H B o, L4 O 1D O T 0 % @ — rp
U L3 5‘1 ‘@'% - Jg 2 l? 21 :.4 “}3.? v 8, @ j @ 2 iy & Tly
& £z 3 a N4 o7 (abe| (abgl Gabel am =
4.\ B v %R SN 5 A e & "B "R e
o T — eo0e Simplified :: Features total: 2332, filtered: 2332, selected. P
Vele awmy 6ozt QMZBR B8 ¢ Y 2o P o0 B K@= :
—1 B-c Open field calculator (Ctrl+1) » Miscellaneous (...
:@D /[ Simpiitied 123 WallBlobs =/ £ | 123 WallBlobs By o e Selected * Raster (1)
[T clipped WalBicba ¥ Vector (v.*) '
VA [7] Vectorized o ¥ vbufferc...
v I Reclassified Grid U o vbufer, Q
@ BN - 0 & vbuid.ch... | [T
J Gk 0 o vhuidpol... ||l
N v " ProfileCurvature-clipped 3  volass - =
W 0276952 A ) ¥ V»C:Ea" -T. @
@é 0.04982 o vcleana... a
0 & vdbselec
I [H curvaturemask 5 oot =
& | .E! Profile Curvature . ) z pron
0.277418 )
9 0.255802 0 » vdistance.. >
(+] 7 & vdrape- ... o]
v ¥ Filtered Grid o & vedit-Ed... )
W3 I 160238 & ¢ vextract -
438519 9 0 & vextrud (1]
V”v v B Vernazza-dem25cm-subset & vgener EA
I 161.698 10 0 o vgenerali... [l
200831 0 0 vgenerali..  [lsg
[ subseta " o vgeneraii... [P
[l subset2 12 Y & vhull-Pr...
[] subset1 0 & vin.ascii.. .
v ¥ dgm-asc-subset L & Vvin.ascii.. =
W 238.491 14 0 ¥ @
325.037 0 v
v ¥ dgm_asc 15 v Vi ; -
vin.lines -...
169.186 = v
u 436,656 ¥ Show Al Features ¢ vinmapg... |
& vinwls - I... =
& vinfo-O..
o vkov-Ra.. [l ]
o vkemel.r. w
o vkemelv... n
¢ vidarcor... L
B e |
Toggles the editing state of the current layer Coordinate 555891.2,4887270.2 5 Scale 1:40,802,235 & Magnifier 100% 2 Rotation 0.0 & Render ) EPSG:4326 @ w

. In the field calculator, make sure that the "Create a new field" box is checked. Add an
"Qutput field name" (e.g. "id"), double click on $id in Record to add it to the expression,
then click "OK"



# Field calculator

Only update 0 selected features
| | Create a new field || Update existing field

|| Create virtual field
Output field name  id
Output field type Whole number (integer)

Qutput field length |10 ~| Precision 0 2

=+ - 1] A (] )]

WallBlobs

<>

iSearch |

Conversions
Date and Time
Fields and Values
Fuzzy Matching
General
Geometry
Math
Operators
Record
attribute
S$eourrentfeature
get_feature
$id

Tid

4YTYYVYYYIYYY

$acale
uuid
String
Variables
Recent (fieldcalc)

L

Output preview: 0

Help Cancel OK

ii) Repeat to create a field for area, except use Geometry -> $area in the expression



Only update 0 selected features
|| Create a new field
|| Create virtual field

& Field calculator

|| Update existing field

Output field name [area

Output field type Decimal number (real}

WallBlobs

Output field length 10 = Precision

2 ¢

<>

=+ -] A ] ] )] W

Garea

Output preview: 0.18701171875

Help

| Search

» Fields and Values

» Fuzzy Matching

» General

v Geometry
angle_at_vertex

area
azimuth
boundary
bounds
bounds_height
bounds_width
buffer

centroid
closest_point
combine
contains
convex_hull
Crosses

Cancel

OK

. Attribute table should now have 3 fields



Simplified :: Features total: 2332

WzBc 28 980T P a0 BRERE =

selected: O

123 WallBlobs = £ |123 WallBlobs Update All | Update Selected
WallBlobs id area
1 0 0 0.19
2 0 1 0.12
3 0 10 0.25
4 0 100 0.37
5 0 1000 0.01
6 0 1001 0.00
- 0 1002 0.00
8 0 1003 0.03
9 0 1004 0.01
10 0 1005 0.00
1 0 1006 0.03
12 0 1007 0.01
13 0 1008 0.00
14 0 1009 0.05
15 0 101 0.25
7 Show All Features _ B
. Save edits.

iii) Delete small polygons. In the attribute table, click on the area field to sort polygons by
size from small to large

099 f

nplified :: Features total: 2332, filtered: 2332, selected: 0

/ # B R st HENLTESD 80 GERE &

WallBlobs id Carea & )
234 .

1 [v]
2 1] 248 0.00
3 [¥] 255 0.00
3 0 284 0.00
5 0 266 0.00
& 0 275 0.00
7 [1] 282 0.00
8 [¥] 292 0.00
g [1] 283 0.00
10 0 297 0.00
11 0 288 0.00
12 [1] 289 0.00
13 [¥] 304 0.00
14 1] 305 0.00
15 [1] 306 0.00
16 [1] an 0.00
0 312 0.00
T Show All Features _ Bl l=

. Highlight rows that have small polygons (< 5.0 m2 for my example) and click the "Delete
selected features" button to delete



WzBe B0 ¢ LT B P 06 BBE S

123 WallBlobs =IFE Update Al Update Selected
WallBlabs id area A

i V] 281 0.01

5 [1] 286 0.01

6 [1] 287 0.01

7 [1] 288 0.01

8 [1] 294 0.01

g [1] 295 0.01

10 [1] 296 0.01

1 [1] 300 0.01

12 [1] 301 0.01

13 [1] 307 0.01

14 [1] 308 0.01

15 [1] 314 0.01

186 [1] 315 0.01

17 [1] 37 0.01

18 [1] 318 0.01

v

T Show All Features = | =

. I suggest deleting a small number of polygons at a time and saving edits often.

7. Skeletonize the polygons to create lines using Centerline command line tool. Before
installing, make sure you have a Python2 environment. If you do not already have Python,
| recommend using miniconda (https://conda.io/miniconda.html). Here is some
information about managing miniconda (https://conda.io/docs/using/envs.html). Create an
environment using Python 2x, not Python 3x. Then install numpy, scipy, and GDAI/OGR
(use "conda install numpy"). Once all of the dependencies have been installed, install
Centerline "pip install centerline".

Open a Terminal window (if using Mac) or Command Line (Windows). Navigate to location of
Simplified Layer (cd path/to/file/location). Use the command "shp2centerline polygon.shp
lines.shp 1.0"

(python2) Eastern-Box:interim jenglaubius$ shp2centerline WallBlobs-Simplified.shp WallBlobs-Lines.shp 1.0
Importing polygons from: WallBlobs-Simplified.shp

Calculating centerlines.

Exporting centerlines to: WallBlobs-Lines.shp

Calculation complete.

. The command will let you know when it is finished. Open the new shapefile in QGIS and
zoom in to look at the results.


https://conda.io/miniconda.html)
https://conda.io/docs/using/envs.html)

/ [] wallBlobs-Simplified
[ Vectorized
~ I® Reclassified Grid
H -0
-0.01
v ¥ ProfileCurvature-clipped
W 0276852
0.24982
~ [H curvatureMask
¥ Profile Curvature

¥ Vernazza-dem25cm-subset1
W 161.698
290.831
[} subseta
M subset2
] subset1
v [ dgm-asc-subset
W 238491

325.037

v B dgm asc
W 169.186
436.656

Coordinate /6081.95,4887365.28 | Scale 1:14,201,261 Magnifier 100% | 3 Rolation 0.0

v Recently used algorithms
& Vv.generalize.smooth - V...
& v.generalize simplify - V...
& v.generalize displacem...
& Viype - Change the typ...
& Vbuild.check - Checks ...
& vdissolve - Dissolves b...
» » GDALIOGR [48 geoalgorit...
»  GRASS GIS 7 commands ...
» & Models [0 geoalgorithms]
» @ Orfeo Toolbox (Image anal...
» # QGIS geoalgorithms [116 ...
» & SAGA (2.2.3) [248 geoalg...
» [E Scripts [0 geoalgorithms]

You can add more algorithms to the
toolbox,

B
4

8. Remove small dangles (extraneous lines): Grass -> Vector -> v.clean. Set Layer to clean to
your line layer, Cleaning tool = rmdangle, set a threshold for length of lines that may be
removed (I started with 0.1, which did virtually nothing), and save the cleaned file



Log  Help Run as batch process...
Layer to clean
WallBlobs-Lines [EPSG:4326] - | D

Cleaning tool

rmdangle

Threshold
0.500000 a|;

GRASS GIS 7 region extent (xmin, xmax, ymin, ymax)

[Leave blank to use min covering extent]
p Advanced parameters

Cleaned
[Users/jenglaubius/Documents/ATM/agrterrmodel/data/interim/WallLines-Clean2.shp

Open output file after running algerithm
Errors

[Save to temporary file)

Open output file after running algorithm

Close Run

. With each iteration, | used the cleaned file created during the previous iteration.

Clean1: 0.1 threshold
Clean2: 0.5 threshold
Clean3: 1.0 threshold
Clean4: 1.5 threshold
Clean5: 2.0 threshold
Clean6: 3.0 threshold
| stopped after the 3.0 threshold when most dangles were removed



o0 e QGIS 2.18.0 - Vernazza-ExtractTerraceWalls

006
Search...

v Recently used algorithms
leaned ¢ v.generalize.simplify - Vecto...
~— Cleaned & V.generalize displacement -...

S RRE R RS,

— Cleaned & Viype - Change the type of ...
~— Cleaned ¢ V.build.check - Checks fort...
Cleaned & Vv.dissolve - Dissolves boun...
— WallBlobs-Lines & v.clean - Toolset for cleanin...
© [] WallBlobs-Simplified \ > i GDALIOGR [48 geoalgorithms]
[ Vectorized v & GRASS GIS 7 commands [314...
= » Imagery (i.%)
¥ Reclassified Grid » Miscellaneous (m.*)
[ EY » Raster (")
-0.01 v Vector (v.*)
| B ProfileCurvature-clipped & vbulfer.column - Create. ..
W 0276052 & vbufterdistance - Creat...
0.24082 & vbuild.check - Checks ...
YAl [ curvaturemask & vibuild.polylines - Buids...
v B Profile C = & v.class - Classifies attrib...
i u :22;‘;: & V.clean.advanced - Tool...
""" - g & v.db.select - Prints vect...
v O I Frered aria & Vv.delaunay - Createsa ...
I 1e0238 & vadissolve - Dissolves b...
. e & vdistance - Finds the n...
v ¥ Vernazza-dem25cm-subset1 & vadrape - Convents vect...
Il 161.698 & v.edit - Edits a vector m...
200831 & vextract - Selecls vecto...
[T subsets & vexirude - Extrudes flat ...
M subset2 & vgeneralize.displaceme...
] subsett & vageneralize.network - V...
v [ dgm-asc-subset & vgeneralize.simplify - V...
1 238.491 & v.generalize.smooth - V...
325.037 & vhull - Produces a conv...
v [ dgm_ asc ¢ vin.ascii.points - Create. ...
W 169.186 You can add more algorithms to the toolbox,
436.656

Coordinate 556145.8,4887261.6 9 Scale 1:10,662,570 Magnifier 100% | 3 Rotation 0.0 2 I Render @ EPSG4326 | @ | ‘
4

. Notice that each different color shows the iteration in which it was removed.

8. Merge individual segments into polylines. The cleaned layer contains thousands of
individual segments that make up each wall. For example, after cleaning, my cleaned layer
has 34,781 individual features (segments)

YV NV N0

{ ‘WallLines-Clean6 :: Features total: 34781 filte

id

1 2049
2
a 2049
4
5 2049
]

2049

L= - B |




. Before we can use tools in QGIS to simplify the lines, the individual segments need to be
merged into polylines.

GRASS -> Vector -> v.build.polylines: Input layer (cleaned layer); Category number mode =
"first" (adds id number to attribute table for new polyline layer); DO NOT save to file. On my

system, this caused the tool to fail
i o

Log  Help Run as batch process...

Name of input vector map

WallLines-Cleant [EPSG:4326) - |
Category number mode

first
GRASS GIS 7 region extent (xmin, xmax, ymin, ymax)

[Leave blank to use min covering extent]

p Advanced parameters

Polylines

[Save to temporary file)

Close Run

10. Straighten the new polylines using GRASS -> Vector -> v.generalize.smooth. Input
Polylines layer, method = sliding_averaging to create smooth lines, | changed Slide of
computed point toward the original point to 1.00, but this parameter can be modified



Log  Help Run as batch process...

Input layer

Polylines [EPSG:4328] - || D
method

sliding_averaging
Maximal tolerance value

1.000000 g

3

Look-ahead parameter

7 "
Slide of computed point toward the original point

1.000000 a2
Minimum angle between two consecutive segments in Hermite method

3.000000 :

Snakes alpha parameter

1.000000 o
Snakes beta parameter
1.000000 °

3

Do not copy attributes
Disable loop support
GRASS GIS 7 region extent (xmin, xmax, ymin, ymax)

[Leave blank to use min covering extent]
p Advanced parameters

Smoothed

[Qawa te tammneans filal

Close Run

. The resulting polylines have fewer bends in them as you can see from



11.

where the orange lines are the pre-smoothed polylines, while the red lines are the
smoothed polylines.

At this point, there may be some extraneous lines that have not been removed by the
previous steps. Manual editing can fix those issues. Make sure that the Digitizing Toolbar
is turned on



& QGIS Project Edit

Addresses

Layer Settings
Show Tab Bar

) Pan Map
’:bs % Pan Map to Selection
4% Zoom In
i L P 7oom Out
=] Layes]  Select
« @ % T @, |dentify Features
Polylines 2 Statistical Summary
| — WallLines-  ¥3 7oom Full
— WallBlobs: 1) 7o0m to Layer
[l waliBlobs 15 760m to Selection
Il Vectorized 4d Zoom Last
v ¥ Reclassifi¢
| B :
-0.01
v [ I ProfileCur  pecorations
W 0276952 % Map Tips
0.24982 -
- % New Bookmark...
[H curvaturel |
- Show Bookmarks
v ¥ Profilecur
W 0277418 % Refresh
0.255802 Paneis
4 I Fittored G Toolbars
I 160238 Toggle Full Screen Mode
e Enter Full Screen
v [ VY ————
W 161.698
200.831
v [ | [ dgm-asc-subset
W 238.491
325.037
v | [ dgm_asc
M 169.186
436.656

Raster Database Web MMQGIS Processing Window Help $3 & 4D = [ o) 100% @B EE Wed13:16 Q

orrMods| To-Do

QGIS 2.18.0 - Vernazza- ExtractTerraceWalls

Advanced Digitizing Toolbar
v Attributes Toolbar
Database Toolbar
Digitizing Toolbar
v Help Toolbar
Label Toolbar
v Manage Layers Toolbar
v Map Navigation Toolbar
Plugins Toolbar
v Project Toolbar
Raster Toolbar
v Vector Toolbar
v Web Toolbar

A“

Coordinate 6099.08,4887380.64 | | Scale 1:12,482,141 BI‘

PRPRAMBIS & oy &y = B,, [ B
1 N Q6 Processing Tooloox
Search.

& vbuild polylines - Builds poly..
» 4» GDAL/OGR [48 geoalgorithms]
v 4 GRASS GIS 7 commands [314 ...
» Imagery (i.*)
» Miscellaneous (m.*)
» Raster (")
v Vector (v.*)
& vbuffer.column - Creates...
& Vv.bufferdistance - Create...
¢ V.build.check - Checks fo...
¢ V.build.polylines - Builds ...
¢ V.class - Classifies attribu...
& veclean - Toolset for clean...
& vlean.advanced - Tools...
& vadb.select - Prints vector...
& vdelaunay - Creates aD...
& vdissolve - Dissolves bo...
& vdistance - Finds the ne...
& v.drape - Converts vector..
& vedit - Edits a vector ma...
& Vv.extract - Selects vector ...
& vextrude - Extrudes flat v...
& vgeneralize displacemen...

& vhull - Praduces a conve...
& v.in.ascil points - Creates....
standard - Creat...
& vin.dxi - Converts files in....
& Vin.geonames - Imports ..
& vin.lidar - Converts LAS ...
& Vvin.lines - Import ASCII x...
& vin.mapgen - Imports Ma...
s vinwfs - Imoort GetFeat.
add more alg s fo the

to start pruning the polylines. Double check that the layer being edited is the Smoothed
layer (should have pencil beside it in Layers Panel). Click on a segment you would like to
delete or adjust, then click on one of the red boxes to adjust that node (note: when a node
is selected it turns blue,

N @ m

-/

g 3w o@D O



)- Individual polylines or segments can also be deleted using the Select features by area or
single click tool to select 1 or more segments (they turn yellow,

[ XX ]

OO0 OD0NES

W 0276952
0.24982
, [l curvatureMask
v [ Profile Curvature
A W 0277418
L 0.255802
/[y v [ Filtered Grid
| 160.238
436.779

v [ vernazza-dem25cm-s...

W 161608
200831
v [ dgm-asc-subset
W 238491
325,087
v [ dgm_asc
W 160186
436,656

¥ ProfileCurvature-clip...

D 6 Proc Toolbo
Search...
& V.build.polylines - Builds poly...
» i GDALIOGR (48 geoalgorithms]
vy GRASS GIS 7 commands (314 ...
» Imagery (i)
» Miscellaneous (m.)
» Raster (1)
v Vector (v.*)
& Vv.buffer.column - Creates...
& v.bufferdistance - Create...
& Vv.build.check - Checks fo...
& Vv.build.polylines - Builds ...
& v.class - Classifies attribu...
& v.clean - Toolset for clean...
& Vv.clean.advanced - Tools...
& v.db.select - Prints vector...

¢ v.delaunay - Creates aD...
& v.dissolve - Dissolves bo...

& vdistance - Finds the ne...

& v.drape - Converts vector...
& v.edit - Edits a vector ma...
& v.extract - Selects vector ...
& v.extrude - Extrudes flat v...
& v.generalize.displacemen...
& v.generalize.network - Ve...
& Vv.generalize.simplify - Ve...

& Vhull - Produces a conve...
& Vvdn.ascii.points - Creates...
¢ Vvdn.ascii.standard - Creat...
& vin.dxf - Converts files in...
& vingeonames - Imports ...
& vdnllidar - Converts LAS ...
& vdnllines - Import ASCII x...
& Vvin.mapgen - Imports Ma...

nwfs - Imoort GetFeat
‘ You can add more algorithms to the toolbox,

1 feature(s) selected on layer Smoothed.

Coordinate 6138.22,4887370.08 | 9§ Scale  1:12,482,141 Magnifer 100% 2| Rotation 00

BELTL L AR

) and then using Delete button on keyboard.

| use a slope layer derived from the DEM as background to help with deciding which segments
are extraneous or need to be separated



QGIS 2.18.0 - Vernazza-ExtractTerraceWalls

NEBERRKIS L LSHLPL L IBIN R 8 & i &y I EE 8
¥./ B o lovo & @ 8 B feswi
(xX5) Layers Panel

< 1@ ®; ? ﬁuv 3 |
+ — Smoothed
' — Polylines
— WallLines-Cleané
— WallBlobs-Lines
v || wallBlobs-Simplified
[T vectorized
v o~ [ Vernazza-25cm-Slope
W 9.73652
54.5512
v ¥ Reclassified Grid
W 10
-0.01
v o~ [ ProfileCurvature-clip...
Il -0.276952
0.24982
[ curvatureMask
v v I Profile Curvature
W ©0.277418
0.255802
v ¥ Filtered Grid
Il 169.238
436.779
v o~ [ Vernazza-dem25cm-s...
Il 161.698
290.831
v ¥ dgm-asc-subset
W 238.491
325.037
v ¥ dgm_asc
Il 169.186
436.656

<E2AHD8 aXNAS

Here is an example of the final, simplified terrace features




